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▪▪ Do not use this product in an outdoor environment.

▪▪ Do not use this product near water or moisture. Electric shock may result.

▪▪ This product is not intended for use by unsupervised children. Always provide proper adult supervision when 
using this product around children.

▪▪ At least two qualified service technicians should perform the installation and removal procedure. Failure to do 
so could result in serious personal injury and/or property damage.

▪▪ Before installation, take the wall material and wall strength into consideration.

▪▪ Always place this product on a stable and level surface.

▪▪ Use only the designated MooreCo stands and wall mounts.

▪▪ Make sure the mounting screws are properly sized to handle the weight of this product.

▪▪ Make sure the mounting hardware is securely anchored to a solid structure.

▪▪ Only plug the power cord or power adaptor into an AC power outlet with the proper and indicated power 
supply voltage. Only use grounded AC power outlets. Use of this product with the wrong power supply 
voltage may result in property damage, fire, or shock.

▪▪ If the power cord or power plug or power adaptor cannot be plugged into the AC power outlet, contact a 
licensed electrician to replace the AC power outlet with a properly grounded (earthed) one.

Safety Information

This product was designed for and is intended for use indoor via a USB cable connected to a desktop or laptop 
computer. Using this product in an outdoor and/or wet environment could damage this product and create 
potentially unsafe conditions.

Meaning of Signal Words

Indicates a potential hazard that could result in serious injury or 
death and/or property damage.

Indicates hazards that could result in minor or moderate injury 
and/or property damage.

WARNING

CAUTION

Please read, understand and follow all safety information contained in this User Manual before installation and use 
of this product:

WARNING WARNING WARNING
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▪▪ When you operate this product, the AC power outlet should be near this product and easily accessible.

▪▪ The fact that this product operates satisfactorily does not imply that the AC power outlet is grounded and 
that the installation is completely safe. For your safety, if you are in any doubt about the grounding status of 
the AC power outlet, consult a qualified electrician.

▪▪ Do not defeat the purpose of the grounded AC power outlet (for example, do not use an outlet converter).

▪▪ Always ensure that the power cord or power adaptor is securely and firmly plugged into the approved AC 
power outlet. Otherwise, possible electric shock or fire may occur.

▪▪ Do not pull, bend, rest objects on, or chafe the power cord or power adaptor. Damage to the power cord or 
power adaptor can cause fire or electric shock.

▪▪ Do not attempt to repair the power cord or power adaptor if it becomes damaged. Contact an authorized 
service representative for a replacement.

▪▪ Periodically clean the power cord and power adaptor to ensure the connection is free of dust. Always ensure 
that the power cord and power adaptor are unplugged before cleaning. Dirty power cord connections or 
power adaptor connections may result in a fire.

▪▪ Never touch the power cord or power adaptor with wet hands. Electric shock will result.

▪▪ Stop operation immediately if your product emits smoke, excessive heat, abnormal smell or unusual noise. 
These conditions may cause fire or electronic shock. Immediately turn your product off and unplug the 
power cord and/or power adaptor, and contact an authorized service representative for service.

▪▪ When disconnecting this product from an AC power outlet, pull on the power plug and NOT on the power 
cord. Pulling on a power cord forcibly can damage it and cause fire or electric shock.

▪▪ If an object or liquid get inside this product, turn the product off and unplug the power immediately. Contact 
an authorized service representative for service. Operating the contaminated product can cause fire or 
electronic shock.

▪▪ Never open or remove unit covers that are screwed with screws. A high-voltage component can cause 
electric shock.

▪▪ Do not alter this product or modify any parts of the board. Alteration or modification can cause fire or 
electronic shock

▪▪ Before cleaning this product, unplug the power cord and/or power adaptor. Electric shock may result 
otherwise.

▪▪ Do not open or alter the casing of this product. Electric shock or injury may result.

▪▪ Be careful about the location of the power cord, power plug or power adaptor to avoid it tripping someone 
or causing this product to fall, etc. It may cause injury or product failure.

▪▪ Do not place this product, power cord, power adaptor, or accessories where it may be tripped on. Failure to 
do say may cause injury.

Safety Information (continued)
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▪▪ Use only the included power cord and power adaptor. If another power cord or power plug or power adaptor 
is used, fire or electric shock might result.

▪▪ Do not operate this product in a location with high temperature or high humidity. This product is suitable to 
work under: Temperature: 10°C to 40°C; Humidity: 10% to 80%; NO condensation.

▪▪ Unplug the power cord, power plug or power adaptor from the AC power outlet when:

The power cord or power supply plug is damaged.

A liquid is spilled onto this product.

This product is exposed to rain or water.

This product malfunctions and/or need repairing.

This product falls or after its cabinet is damaged.

CAUTION CAUTION CAUTION

▪▪ This product must be disposed in accordance with the relevant federal, state, and local laws and 
regulations.

▪▪ Do not install this product except by qualified service personnel.

▪▪ Avoid fire and heat source above 100°C.

▪▪ When this product is not used over an extended period of time, switch it off and unplug the power plug or 
power adaptor. If it is unused and is left connected to a power source for a long period, degraded insulation 
may cause electronic shock, current leakage or fire.

▪▪ Do not position this product in a location where it is unstable.

▪▪ Do not place this product in a hot, humid or dusty environment. Prolonged exposure to these adverse 
conditions may cause fire or electric shock.

▪▪ When moving this product, be sure to unplug the power cord, plug or power adaptor from the AC power 
outlet. If this product is moved with the power cord or plug or power adaptor attached, it can cause damage 
to the power cord, plug or power adaptor which could result in fire or electric shock.

▪▪ After installing or moving this product, lock the casters when it is hanging on a mobile stand.

▪▪ If this product is falls down or is damaged, turn this product off and unplug the power cord or power plug or 
power adaptor. Otherwise, it may cause fire or electric shock.

▪▪ Do not put drinks, other liquids or heavy items on the tray or screen. Accidental spillage of liquid into this 
product may cause severe damage. If this occurs, turn this product off, unplug the power cord or power 
plug or power adaptor and contact an authorized service representative for service.

▪▪ Do not lean against this product even if this product is mounted on the wall.

▪▪ When this product is not used over an extended period of time, take the batteries out of the electronic 
stylus. Otherwise the batteries may leak. Do not use the leaked batteries.
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▪▪ Do not install this product where it may be exposed to direct sunlight, near heating equipment, or near air-
conditioning vents.

▪▪ Do not install this product in strong sunlight or strong lighting.

▪▪ Do not install this product in locations where the temperature may change suddenly.

▪▪ Do not erase with a dirty eraser.

▪▪ Use Green Erase whiteboard cleaner for hard-to-erase stains.

▪▪ Fasten the screws tightly to avoid the product falling which may cause injury or damage.

▪▪ Before installation, take the wall material and wall strength into consideration. For details, please consult your 
dealer.

Safety Information (continued)
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Included with Your OneBoard

After unpacking, please make sure all of the following parts (subject to your purchase) are present:

OneBoard - USB

Item	 Quantity

OneBoard	 1

Tray	 1

Hardware pack (Z-hanger, side tubes, screws, screw anchors)	 1

USB cable	 1

Software CD-ROM with user manual	 1

Pointers (marker size and pen size)	 2

Eraser	 1

Wireless USB adapter (wireless kit only)	 1
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OneBoard Software Installation

DO NOT connect OneBoard USB cable or optional wireless USB adapter to your computer before following the 
steps below.

MAC USERS – Download the Mac drivers at www.moorecoinc.com/oneboard under “Software”

Step 1.	 Install OneBoard software

1.	 To run the installation program, double-click “OneBoard_Quad_Setup.exe” on your 
installation CD. You may see a progress bar initially.

2.	 Click “Next” to begin installing the software.

3.	 If prompted, choose the prerequisites to install, click “Next” to continue.

4.	 Choose the installation destination and click “Next” to continue. You may need to click 
“Install” on the next screen.

5.	 Your installation progress will be displayed.

6.	 Click “Finish” to exit the installation program after the OneBoard software has been 
installed.
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Wired Boards Only

6.	 Plug the USB cable into your OneBoard and connect the other end to your PC. 

7.	 The OneBoard has been detected and is ready to use when your computer displays the 
following dialog:

8.	 Once your board is connected for the first time, you will need to calibrate the software 
using the directions on page 12.

Wireless Boards Only

6.	 Plug the included power adapter into the wall and connect the USB cable to the 
OneBoard.  

7.	 Plug the OneBoard USB wireless receiver into your PC.

8.	 If this is your first time using the USB wireless receiver or using it with this OneBoard, you 
will need to wait for Windows to install the drivers and then open the Wireless Settings 
screen. You can find the Wireless Settings screen by right-clicking the driver icon in the 
notification area and choosing “Wireless Settings”. 

9.	 When you first open the Wireless Settings, it will scan for your OneBoard. Once your 
OneBoard has been located, use the “Pair” button to connect your computer and your 
OneBoard. Under normal circumstances, you will only need to pair your computer and your 
OneBoard the very first time you use them together. The connection will be automatic from 
then on, given that steps 6 and 7 have been followed.

10.	Once your board is connected for the first time, you will need to calibrate the software 
using the directions on page 12.
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OneBoard Connection

In order to use the OneBoard, you must have a PC or Mac, projector, and OneBoard USB connected as shown 
in the figure below. Wireless OneBoards use a USB wireless receiver to connect the OneBoard to the PC. 
Once connected, you will need to adjust your projector so that the projected image is fully within the OneBoard 
working area.

Wireless OneBoard:
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OneBoard Configuration

Windows Vista and Windows 7 Only

Microsoft Windows Vista and Microsoft Windows 7 PCs come with native touch-board driver functionality. If you 
intend to use your Quad User OneBoard with the included software, you will need to configure these two options 
in Windows.

1.	 Connect the Quad User OneBoard to your PC and wait for the OneBoard software to verify 
that it has connected.

2.	 Go to the Control Panel.

3.	 Choose “Pen and Touch”.

4.	 Under the “Flicks” tab, UNCHECK  “Use flicks to perform common actions quickly and 
easily”.

5.	 Under the “Touch” tab, CHECK “Use your finger as an input device” and CHECK “Enable 
multi-touch gestures and linking”.

6.	 Press “Ok” to save your changes.
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OneBoard Configuration (continued)

All Users

Open the OneBoard driver by double-clicking the OneBoard driver icon on your desktop.

To access the settings, right click the OneBoard icon in your notification area, and choose “settings”.

Screen Calibration

You will need to calibrate the software after you connect the OneBoard to your computer for the first time and 
any time the projector is moved or the resolution is changed. You can open this screen by right clicking the 
OneBoard icon in the notification area of your computer and selecting “Calibrate”.

1.	 Use your finger or a pen to point at each of the red cross hairs. Be sure to point on each cross hair 
accurately – we suggest using a pointer or closed marker to calibrate. As you touch each point, the 
next cross hair will “activate” for you to calibrate. 

2.	 After calibrating, you will be prompted to save the profile. Click “Ok”.

Language

The OneBoard software supports multiple languages. To change languages, right click the OneBoard icon in the 
notification area of your computer and use “Configuration”. You may also need to use the “View” > “Language” 
option in the annotation software.

Auto Run

If you do not want the OneBoard software to automatically start with your Windows installation, you can uncheck 
this box to disable that.  
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Software Operation

Microsoft Office 2003 and newer:

Users of Microsoft Office 2003 and newer versions will notice some special features are activated in some of 
those programs when using the OneBoard.

The PowerPoint, Excel, and Word programs will all show “Ink Tools” functionality. This functionality allows you to 
“draw” inside of the respective program and save those annotations within the office format file.

These tools cannot interoperate with the OneBoard software. You must use the Microsoft Office “Ink Tools” menu 
to make, edit, and delete any of these marks.

Office 2003 Office 2007/2010

Whiteboard Mode

The default mode for the OneBoard software is the “whiteboard” mode. This mode allows for access to all 
functions of the annotation software. 
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Software Operation (continued)

Whiteboard Mode Functions

New Document Create a new OneBoard document

Open Document Open a saved OneBoard document (.tbd file)

Save Document
Save the current annotation screens as a OneBoard document or as a jpg, 
pdf, etc.

Undo Undo the previous action

Redo Redo the last action

Cut Cut the selected object

Copy Copy the selected object

Paste Paste the cut or copied object

Delete Delete the selected object

Enlarge Enlarge the selected object

Playback Play back from start to end, the annotations that have been made

Curtain Show or hide pieces of the screen

Spotlight “Spotlight” certain objects by hiding the rest of the content

Select Tool Select an object or group of objects to move or interact with

Move Tool Scroll around the annotation content area

Pen Tool*
Show submenu for: select pen type, line color, line style, and transparency, 
see page 17 for drop down menu

Shapes Tool
Show submenu for: line, curve, triangle, square, parallelogram, oval, circle, 
graph axis, pentagon, ruler, compass, and protractor

Textbox Tool Insert a textbox container in the content area

Eraser Tool Show submenu for: eraser, area erase

Insert Picture Insert an image from the local computer

Video Player Insert a video player
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Whiteboard Mode Functions (continued)

Screen Capture Capture a full screenshot or partial screenshot, inserts into content area

Document Camera Open tool for viewing and importing webcam or document camera images

Page List Display a list of all pages within the current OneBoard document

Image Library Display the image library, sorted by category

Fill / Lines Show options to change line style, color, thickness, opacity, and shape fill

Hyperlink
Manage hyperlinks to link objects to URLs or other pages in the current 
document

Ruler
Displays an on-screen ruler that can be stretched to show more of the chosen 
unit 

New Page Create a new page in the current OneBoard document

Previous Page Show the previous page in the current OneBoard Document

Next Page Show the next page in the current OneBoard document

Delete All Delete all objects on the current page

Insert Formula
Create and edit mathematical formulas, including mathematical symbols, and 
insert on the screen

Video Player Select and play a video with the ability to write and draw on the screen

Music Player
Select, place, and click to play a music file as needed or delete from the 
screen when finished listening

Screen Recorder Record your screen along with optional audio and save your recording

Flash Player Insert a flash file into the content area

Timer Count down from a set number or use as a stopwatch

Text Reminder
Set your preferences then receive a notice message at the predetermined 
time

Math Function Write and graph linear equations

Presentation Mode Use the software in full screen mode with a toolbar of essential tools

Calculator Opens your operating system’s calculator

Insert 3D*
Choose an existing 3D file (*DAE or *KMZ) and open it on screen. See page 
17 for submenu icons
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Software Operation (continued)

Soft Keyboard
Use a keyboard with the board and choose to have it float on screen or be 
docked above or below screen

Regular Polygon
Choose between 10 shapes, then choose color, outline, and transparency, 
and place on screen

Geometry
Choose between 12 shapes, then choose color, outline, and transparency, 
and place on screen

Text Speaker Click any line of text on the screen and it will be read aloud

Line
Create a straight or perfectly curved line or arrow and choose color, outline, 
and transparency

Switch Will put the side toolbar on the opposite side of the screen

SketchUp Warehouse
Search for 3D objects, choose one, download, drag onto screen and start 
manipulating the object

Print Preview Preview what the screen will look like when printed

Print Print the screen

Web Image Search Use to open the search bar on the default search engine, insert images

Fill Show options to change shape fill and transparency

Full Screen Converts screen into full screen mode with toolbar 

Compass Displays on-screen compass and pencil

Protractor Displays on-screen protractor

Additional Explanation of Tools

The tools in which operation is more complex are explained further on page 21. This includes the following:

▪▪ Web Image Search

▪▪ Video Player

▪▪ Screen Capture

▪▪ Screen Recorder

▪▪ Ruler

▪▪ Insert > Web Browser

▪▪ Protractor

▪▪ Compass

▪▪ Timer

▪▪ Enlarge

▪▪ Document Camera
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Submenu Mode Functions

Marker Pen Standard pen style

Laser Pen Flashing pen style, useful for drawing attention to an object

Brush Pen Write in paint brush style

Highlighter Ability to highlight any object or text on screen

Calligraphy Pen Write in calligraphy style

Smart Pen Automatically converts drawn “shapes” to shape objects

Handwriting Recognizer 
Pen

Automatically converts written text to text objects

Dual Color Pen
Creates two planes out of the board, writing changes color based on the 
section of the board written on

Four Color Pen
Creates four planes out of the board, writing changes color based on the 
section of the board written on

Six Color Pen
Creates six planes out of the board, writing changes color based on the 
section of the board written on

Pen Tool Submenu

Rotate Use to rotate the 3D object in a 3D space

Wire Frame Use to see the wire frame of the 3D object

Show Pieces Use to show each piece of the 3D object

Hide Pieces Use to hide a piece(s) of the 3D object, to focus on one section

Screen Shot Use the screen shot the 3D object

Open New Open new 3D object

Pen Tool Ability to write/draw on the 3D object

Delete Delete the 3D object

Play Play a sequence of movements from the 3D object

Leave Leave 3D viewer and close 3D object

3D Object Submenu
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Toolbar Mode/Lite Mode

Toolbar/lite mode can be used while you interact with other programs on your computer. You can 
make notes, highlight objects, and save screenshots of your work.

Toolbar/lite mode contains a basic set of tools. In order to customize which tools appears in toolbar/
lite mode, please visit the “Toolbar Settings” in the full OneBoard program.

When using the toolbar/lite mode, it is necessary to click the Windows icon near the top of the 
toolbar before interacting with other programs. 

Toolbar Mode Functions

Close Closes the toolbar and returns to Whiteboard mode

Pen Tool Draws with the default pen tool

Delete All Delete all objects on the current page

Pen Size Toggles the pen size between large and small

Eraser Tool Erases with the default eraser tool

Pen Color Toggles the pen color

Save Screenshot Takes a screenshot and opens a save dialog box (PNG format)

Background Toggles a white background layer on and off

Operating System Toggle Switch back to your mouse to use the computer features instead of the board

Calligraphy Pen Write in calligraphy style

Handwriting Recognizer 
Pen

Automatically converts written text to text objects

Open Document Open an existing document

New Document Start a new document

Delete Document Delete a document

Zoom In Zoom in on screen or object

Zoom Out Zoom out on screen or object

Software Operation (continued)
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Delete Delete selected object

Image Editor Edit selected object by cropping, sizing, and choosing brightness level

Line & Fill Properties
Choose line color, thickness, transparency, style, start cap and end cap, and 
fill color, type, and transparency

Duplicate Duplicate selected object

Hyperlink Link object to URL, page, or file

Menu Pull up menu by icon or by right clicking

Object Menus

Clicking the small arrow on the top right of 
objects in the working area will allow you to:

▪▪ Lock/unlock objects

▪▪ Group objects

▪▪ Copy/cut/delete

▪▪ Rotate/flip objects

▪▪ Export the graphic 

▪▪ Add a hyperlink 

▪▪ Set/delete animation path

▪▪ Edit properties

▪▪ Change object order

Image Library

The image library includes images, flash video, document templates, and backgrounds 
covering a wide variety of subjects. To use an image from the image library, click and 
drag it from the viewing pane onto the content area. You can add or edit the files that 
appear in the image library by editing the “library” folder under your OneBoard software 
installation folder.

Submenu Functions (continued)
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Editing Fill / Line

You can edit the fill and line colors, widths, and styles of shapes that you add to 
the content area. 

To edit an object, select it with the Select Tool, and then click on the Fill / Lines 
editor button. In this screen, you can change the transparency, fill color, or apply 
a gradient. To change the line color, click the “Line Color” button. Similarly for line 
style and line thickness, you will click their respective buttons.

Hyperlinks

You can see and manage the hyperlinks that you have added to your 
document from this screen.

To add hyperlinks to objects, select “Hyperlink…” from the object menu. 
You can select to link it either to a URL, page of the document, or file on 
the local computer. You can also set the hyperlink active area to be either 
the corner icon or entire object.

Web Image Search

Use the web search icon to search for images online and add them to your documents. This content is provided 
by your default search engine and may not be filtered for inappropriate content.

Video Player

To add a video player to your documents, you can use the video player tool. After clicking the button, a video 
player screen will be added to your document. Use the “open document” button, to choose a video to play in 
the video player screen. 

Screen Capture

Screen capture allows you to select a portion of your screen, or the entire screen and add that shot to your 
annotation content area.

Shows that this object is linked, in this case to an URL.

Software Operation (continued)

Additional Explanation of Tools
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Screen Recorder

Using the Screen Recorder tool will allow users to record the entire screen in video format, along with audio, 
and save that file as an AVI file. Please note that your computer may become sluggish if it does not meet the 
minimum system requirements for this tool (dual-core 2.1GHz+, 1GB+ memory).

Ruler

The ruler tool can be used to measure on-screen objects both in programs (if you switch to toolbar mode after 
opening the ruler tool) or in the annotation screen. The ruler can be changed in terms of units of measurement or 
transparency, and can also be rotated.

Protractor

The protractor tool can be used to measure on-screen objects both in programs (if you switch to toolbar mode 
after opening the ruler tool) or in the annotation screen. The protractor can be zoomed in, out, and rotated to 
help determine angles.

Compass 

The compass tool can be used to draw circles of varying radii. Click the top of the compass to resize the 
compass, the right arm to adjust the radius, and drag the pen tip to draw the circle.

Timer

Available under the “Tools” submenu, a timer is available to either count down from a set number or to be used 
as a stopwatch. These settings can be changed by clicking on the small tools button.

Enlarge

The enlarge tool can be accessed under the “Tools” submenu. The shape of the magnification area can be 
changed as well as the measure of magnification and transparency of non-magnified screen.

Document Camera

Webcams and document cameras can be captured via the web / document camera tool. The settings button 
will give access to options for setting which device to pull video from and what driver to use. Once captured, the 
image will be added to the content area.

Insert > Web Browser

Inserts a browser window onto your OneBoard screen. This content is provided by your default search engine 
and may not be filtered for inappropriate content. Tool does not have an icon, use the “Insert” tab and choose 
“Web Browser” to use.

Additional Explanation of Tools (Continued)
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Notices

Every effort has been made to ensure all information contained in this user guide is correct, but the accuracy or 
completeness is not guaranteed. Before using this product, you must evaluate it and determine if it is suitable for 
your intended application. You assume all risks and liability associated with such use. 

Any statements related to this product which is not contained in this manual or any contrary statements 
contained on your purchase order shall have no force of effect unless expressly agreed upon, in writing, by this 
company. 

Without this company’s permission, reproduction or reprinting this user guide or any part is prohibited. 

The contents of this user guide are subject to change without prior notice.
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Warranty

MooreCo, Inc. (“MooreCo”) warrants that your new OneBoard brand product (“Product’) is free from defects in materials or 
workmanship, subject to the limitations, exclusions, and other provisions as detailed below. This warranty only applies to 
OneBoard Products purchased directly from an authorized MooreCo dealer, and is only valid for the original purchaser and for 
the original installation. The warranty is terminated upon transfer, sale, or modification of the Product. 

If a Product is defective in materials or workmanship, MooreCo will replace or repair it at no charge, subject to the terms and 
conditions of this warranty. This is your sole and exclusive remedy, and repair or replacement of the product will be at the sole 
discretion of MooreCo.  Shipping charges to the repair facility will be the responsibility of the purchaser, and shipping charges 
to return the repaired product to the purchaser will be paid by MooreCo, except for products returned for repair during the 
first 30 days after purchase, in which case all shipping charges will be paid by MooreCo. This warranty is subject to the 
limitations, exclusions and other provisions below, and applies to OneBoard products which are delivered within the United 
States of America and the Commonwealth of Canada.

Exclusions:

This warranty does not apply and no other warranty applies to:
▪▪ Normal wear and tear, which are to be expected over the course of ownership.
▪▪ Damage caused by abuse, misuse, neglect, vandalism, accident, modifications, or water or fire.
▪▪ Damage caused by the carrier in transit, which will be handled as claims against the carrier.
▪▪ Modifications or attachments to the product that are not approved by MooreCo.
▪▪ Unauthorized disassembly or modification, or operation in a manner contrary to the instructions.
▪▪ Products that were not installed, used or maintained in accordance with product instructions and warnings.
▪▪ Products used for rental purposes.
▪▪ Labor and/or materials to remove and replace Products.

OneBoard products are not designed, manufactured or intended for use in hazardous or critical environments or in activities 
requiring emergency or fail-safe operation or in any other activity or application in which failure of the product may pose the 
risk of physical injury or death or environmental harm. MooreCo, Inc. specifically disclaims any express or implied warranty of 
fitness for any dangerous application. 

TO THE EXTENT ALLOWED BY LAW, MOORECO MAKES NO OTHER WARRANTY, EITHER EXPRESS OR IMPLIED, 
INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. MOORECO WILL NOT 
BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES. THIS WARRANTY DOES NOT COVER 
CONSEQUENTIAL DAMAGES, LOSS OF TIME OR USE, OR OTHER INCIDENTAL DAMAGES.

Notice to purchasers for home or personal use:

Federal law does not permit the exclusion of certain implied warranties for consumer products. Therefore, if you are 
purchasing this product for home or personal use, the exclusion of implied warranties noted in the above paragraph does 
not apply to you. Some states do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state.

To obtain service under this limited warranty:

By following the procedures regarding warranty claims outlined below, you can be assured of the best level of service.

1.	Contact MooreCo by phone at 1-800-749-2258 or by mail at 2885 Lorraine Avenue, Temple, Texas 76501 within 30 
days of discovery of the defect. Be prepared to prove you are the original purchaser of the product and provide your 
model number, description of the product, and description of the defect.  Then provide MooreCo with your name, 
address, area code, and telephone number.

2.	MooreCo will review all pertinent information regarding the claim, including inspection of the product if deemed 
appropriate by MooreCo. 

3.	If Mooreco affirms that the product in question is eligible under the conditions of the limited warranty as stated 
above, the customer service representative or another representative of MooreCo will determine whether to provide 
replacement parts, authorize repairs or replace the product. 

PRODUCTS RETURNED TO THE MOORECO FACILITY WITHOUT A RETURN AUTHORIZATION WILL BE REFUSED.
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